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1. User guidance 

This user manual contains a summary of the information needed for installation, 
commissioning and operation. 

Read the user manual entirely and do not use the product unless you have understood its 
content. 

 Target group 

The user manual is intended for skilled technicians and trained and certified operating 
personnel. 

The contents of this user manual must be accessible to people tasked with the installation 
and operation of the software. 

 Warnings 

Structure of the warnings 

Warnings are structured as follows: 

 SIGNAL WORD! Nature and source of the danger. 

Consequences if instructions are not obeyed. 

 Actions to avoid the danger. 

  

 

Types of warnings 

Warnings are distinguished by the type of danger they are warning against: 

 DANGER! Warns of an immediately impending danger that can result in death 
or serious injuries when not avoided.   

 

 WARNING! Warns of a potentially dangerous situation that can result in death or 
serious injuries when not avoided.   

 

 CAUTION! Warns of a potentially dangerous situation that can result in fairly 
serious or light injuries when not avoided.   

 

 NOTICE! Warns of a potentially dangerous situation that results in material or 
environmental damage when not avoided. 

 Tips 

 

Tips on the appropriate use of the device or software and recommendations. 
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 Other symbols 

Instructions 

Structure of the instructions: 

 Instructions for an action. 

 Indication of an outcome, if necessary. 
 

Lists 

Structure of unnumbered lists: 

0 List level 1 

– List level 2 

Structure of numbered lists: 

1) List level 1 

2) List level 1 

1. List level 2 

2. List level 2 

 Applicable documentation 

For the safe and correct use of the installation, observe the additional documentation that 
is delivered with the system, as well as the relevant standards and laws. 

 Keeping 

Store the user manual, including the supplied documentation, readily accessible near the 
system. 

 

 Updated documentation 

The latest version of the document can be obtained from the A. Eberle headquarter. Please 
contact A. Eberle Support (+49(0)911/628108-101, regsys-support@a-eberle.de) or your 
local sales partner. 
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2. Configuration and display software WinREG 

 General 

The WinREG software is used to configure and program the A. Eberle REG-D™ Relay for 
Voltage Control & Transformer Monitoring. WinREG has a modular structure and consists of 
several programs for control and configuration of the Relay for Voltage Control & 
Transformer Monitoring, as well as storage and display of data from it. 

WinREG is designed so that a plurality of subprograms can access the connected devices 
(e.g. Panel and Service) at the same time. An exception is the Terminal. If this is in online 
mode, no access of another WinREG program is possible via this interface. 

The SCADA system connections of the Relay for Voltage Control & Transformer Monitoring 
are performed using the SCADA system configuration software WinConfig. Instructions for 
WinConfig software use are not included in this manual. 

 

 

WinREG version 

The following chapters describe WinREG version 4.2 in detail. 

 

 

 Installation 

To run the WinREG software, the minimum hardware and software configuration is: 

– A Personal Computer with a Pentium core 

– 512 MB RAM 

– 50 MB free disk space 

– A serial interface or an USB with an USB serial adapter,  
or a network card for devices that are connected via TCP/IP 

– Windows 7, Windows 8, Windows 10 

– Windows Server as of 2003 

– Microsoft DotNet Framework Version ≥ 3.5 

 

During installation administrator rights are required 

To install the software you start Windows. Do not insert the installation CD-ROM into the 
CD drive yet. 

 

1. Run the "Software" program in the control panel folder   
("Start/Settings/Control Panel"). 

2. An alphabetical list of all installed programs appears. Check first if WinREG is already 
listed. 
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WinREG under installed programs (Windows 7 example) 

 

If that is the case, the older version should be uninstalled first. This applies even if an 
update is to be installed. The update process is described below. 

 

 

No new installation in an existing WinREG directory 

Absolutely avoid a new installation in an existing WinREG directory containing a 
previous version which should be retained. If, on the other hand, this is a new in-
stallation, or WinREG was uninstalled, please continue with point 6. 

 

3. Click on the line "WinREG" in the program list; it is highlighted. Now click on "Change or 
remove programs".  
Some queries follow as to whether deletion is actually intended. Confirm these. 
However, with the request as to whether shared files should be deleted, select "Keep 
all" (or "Remove none") so as not to delete shared files.  

 

 

Don’t delete the CMMCONN.DAT file 

In particular, the CMMCONN.DAT file should not be deleted because it contains 
your connection settings. 

 

4. The message that various WinREG program components could not be deleted can be 
ignored. 

 

5. Uninstallation ends with the message "Uninstallation successfully completed". 

 

6. Now insert the WinREG CD into the appropriate drive.  
Normally, the installer will start automatically. If this automatic start is disabled on your 
computer, run the program Install.exe from the root directory of your CD drive.  
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REGSys™ installation program 

 

7. The Home screen appears. You can choose the installation language in the left column 
and install the programs you need by clicking on the text in the middle column.  

 

 

Instruction: 

If you received the WinREG installation via email or by other means (A. Eberle 
Homepage, USB pendrive), please run setup.exe directly. The other steps are iden-
tical to installing WinREG from the CD. 

 

8. The program directory c:\programme\a-eberle\WinREG4 is proposed.  
 

9. All further steps are described by appropriate instructions and queries. 

 

10. When the installation is complete, you will find the WinREG Control Center under 
Start/programs. 
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WinREG Control Center (standard version) 

 

The control center program contains the panel, REGSys configuration (REGPara), service, 
terminal, login, desktop load and desktop save. 

The additional modules RegView and Collector (collector/recorder) are optional and 
included only if they have been ordered. The same applies to WinTM and WinDM.  

The additional programs RegView, Collector, WinTM and WinDM must be installed 
separately. If you have installed the additional programs, the respective symbol appears in 
colour automatically after installing the program. 

 

 

The panel does not start 

If, after successful installation, the panel does not start and an error message ap-
pears instead, then please check the installation of Microsoft DotNet Framework 
3.5 or 4 on your PC.  

 

 

USB drivers for devices with the I1 feature 

If your REGSysTM device has an interface to COM1 (feature I1) via USB, the desired 
driver can be installed via the menu item "USB driver for REGSys". If communica-
tion with the device takes place via a serial interface (RS232), USB/serial converter, 
or TCP/IP, installation of the USB driver is not necessary. The driver only works 
with A. Eberle devices which are equipped with a built-in USB interface. Please use 
the driver supplied by the manufacturer of the driver for an external USB/serial 
converter. 
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 Control Center  

The Control Center of the WinREG package unites all of its individual applications: panel, 
terminal, WinREG configuration, parameter setup (REGPara), connection editor and all add-
ons. 

 

 
WinREG Control Center (including optional Collector, REGVIEW and WinTM) 

 

The Control Center allows:  

– Starting each of the WinREG applications 

– Saving a snapshot of all applications running on the desktop with position and 
current device (File\Save desktop) 

– Restoring such a snapshot (File\Load desktop)  

– Common termination of all currently running WinREG applications,  
(File\Exit: all) 

– Termination of the HRServer (communication server of the WinREG) 

– Integration of all WinREG applications and add-ons 

– Access to each help file of the WinREG package 

– Setting of important operating parameters (Options\Settings)  

– Setting connections (Options\Connections) 

 

All applications can also be started from the File menu. 

 

Saving & Restoring the Desktop 

WinREG has a function for storing the image of the current WinREG applications in a file at 
any time, and loading or restoring it again later. Both the positions of all WinREG 
applications and the current devices and their connections are saved. 

To generate the image, select the menu item "File\Save desktop", or click on the Save icon 
in the Control Center and enter an arbitrary name in the subsequent "Save desktop" dialog.  

To restore a once stored image, select "File\Load desktop" or click on the load icon in the 
Control Center and select the desired image from the list of desktop files. Then, all WinREG 
applications that were active at the time of storing are started and set to the old positions. 
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Loading can be terminated with the menu item "File\Cancel load desktop". This is especially 
useful when many applications are to be loaded on a modem connection that is not 
cumulative, as a click on Cancel will only abort the currently running selection process, not 
the entire loading process. 

Please note that the repeated loading of a desktop file – without terminating the earlier 
applications again in advance – calls the WinREG applications and places them exactly one 
above the other. 

 

Language setting 

The language of WinREG can be set in the "Options\Language" menu or using the F9 key. 

 

Backing up and restoring connections 

WinREG connections can be backed up to a file and restored from a file via the menu items 
"Options\Save connections" and "Options\Restore connections". Thereby, for example, all 
connections of an existing WinREG installation can be moved to a new installation on 
another PC. 
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 Communication with an A. Eberle device (e.g. REG-D™) 

2.4.1 Connection settings 

WinREG's communication connections are set up and managed in the menu 
"Options\Connections".  

The default connection is indicated with a white "S" placed in a red ellipse. This connection 
is opened as soon as a WinREG subprogram starts.  

 

 
WinREG "Edit Connections" 

 

A. Eberle devices which are equipped with a USB interface (feature I1), are automatically 
detected by WinREG. If a USB device is connected to the PC, the corresponding driver must 
be installed first. This driver is included on the WinREG CD. If the WinREG connection dialog 
opens, a connection is automatically created for each connected A. Eberle USB device. This 
is confirmed by a message. Subsequently, the desired device can now be selected in the 
connection list. 

With USB devices, the assigned COM interface is displayed in the phone field. This 
information is useful when the A. Eberle USB device is to be used with a program that does 
not support automatic recognition. With the "USB device" button details such as driver 
version of the connected devices can be displayed. 
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Automatic searching for devices 

This function offers the possibility to search for connected A. Eberle devices. The "Device 
and Settings Detection" wizard opens after pressing the automatic search button.  

 

 
WinREG "Device and Settings Detection " 

 

Here, among the existing COM interfaces, you can select which A. Eberle device should be 
searched for. After a device is found, a connection for the device can be set. The 
communication settings are automatically taken over from the device itself. 

 

Manual setup of a COM connection (direct connection, modem, star coupler) 

Start setting up the connection by pressing the "New" button in the "Edit Connections" 
dialog (Options\Connections). 

Select the serial interface type and confirm your choice with Create. 

 

 
Manual setup of a COM connection (1) 

 

In the dialog that opens, set the communication parameters according to the values of the 
A. Eberle device. The figure shows the default values of the device. 
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Manual setup of a COM connection (2) 

 

Parameter Description 

Description Freely selectable text for naming the connection 

Speed Baudrate of the serial communication 

Parity Parity of the serial communication 

Interface COM interface (COM port) on the PC, the COM number can be 
obtained from the control panel (device manager) 

Protocol Handshake of the serial connection, generally, RTS/CTS is 
recommended, however, it must be ensured that the interface 
(particularly USB/serial converters) supports hardware 
handshake. 

Dial the remote 
network via modem. 

Establish a connection via a dial-up modem (e.g. analog modem); 
do not activate with a direct serial connection (null-modem 
cable). 

Telephone number Number of the remote site (such as a modem in the substation) 

Modem initialization String prefix for the number which is sent to the modem. By 
default, the selections ATDT (normal initialization) and ATX3DT0, 
(extension initialization) are possible. Generally, another string 
can also be used. 

Star coupler Siemens 
7XV5550 channel 
number 

Here you can select whether the serial communication is to run 
via a Siemens 7VX5550 star coupler. The channel number 
parameter selects the channel on the star coupler to which the 
A. Eberle device is connected. 

 

Confirm all your entries with OK. 

If the newly created connection is to be opened for a WinREG program (e.g. Panel) you 
want to open, select it as the default connection.  
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Establishment of a TCP/IP (COMServer) connection 

Start setting up the connection by pressing the "New" button in the "Edit Connections" 
dialog (Options\Connections). Select the interface type TCP/IP and confirm your choice with 
Create. 

 

 
Establishment of a TCP/IP (COMServer) connection (1) 

 

In the dialog that opens, set the communication parameters.  

 

 
Establishment of a TCP/IP (COMServer) connection (2) 

 

Parameter Description 

Description Freely selectable text for naming the connection 

IP address of the 
regulator network 

IP address of the COM server, which is connected or integrated to 
the A.Eberle device (REG-P(ED), REG-COM) 

Port TCP/IP port of the COM server on which the communication takes 
place (often used at A.Eberle: 1023, 5001, 8000) 

 

Confirm your entries with OK. 

If the newly created connection is to be opened for a WinREG program (e.g. Panel)  
you want to open, select it as the default connection.   
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2.4.2 Configuration 

Other parameters regarding the communication and general settings are located in the 
menu "Options\WinREG Configuration". 

 

 
WinREG „configuration“ 

 

Parameter Description 

Time between sending and 
receiving (timeout) 

Monitoring time for communication. If an inquiry by the 
WinREG receives no response from the device within the 
set time, the inquiry is terminated. 

HRServer waiting time until 
self-termination… 

The HR server is the communication server of WinREG. It 
runs in the background and coordinates requests from the 
various subprograms of WinREG to the devices. This time 
determines how long the HRServer remains active if all 
WinREG programs are closed. This is helpful, for example, 
when working with a modem connection and the server 
does not have to establish the connection again after each 
program termination and start of another program. With a 
correspondingly long selected follow-up time, the 
connection remains open on changing. 

Time after which modem 
dialling is considered failed. 

Monitoring time for connection establishment via modem. 
After the interval further dial attempts are not made. 

Checksum procedure Setting of the checksum procedure for communication 
between the A. Eberle device and the PC. 

 

Communication with 
WinPQ 

WinREG is able to communicate through the server of the 
WinPQ software. This allows parallel operation of WinPQ 
and WinREG via a serial connection. To this end, the 
WinPQ server must be set to continuous operation and a 
registry entry set (function in the PQ-Manager). 
Caution: 
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Parameter Description 

If the communication with WinPQ is active, WinREG will try 
to reach all connections found in WinPQ and WinREG via 
the PQServer (e.g. COM1, COM3, TCP/IP 192.168.55.199). 
If the PQServer is not active, WinREG cannot connect. 

If the communication is selected via the WinPQ, no UDM 
files can be sent! 

Panel Settings Here you can select the view of the panel to be displayed 
when the panel is started. 

Manage connections public Enables Global Connection Management. All users who 
have set this checkbox access a central connection list in 
the folder ... \ProgramData\withWinREG. Users who have 
not activated central administration continue to work with 
their own connection list. 
There is no automatic transfer of connections between the 
separate connection lists and the central list. If you already 
have a user who has all or most of the relevant 
connections, please secure these connections with "Save 
Connections" function. Then, change the connection 
management into central and restore connections using 
the Restore Connections feature. From this point in time, 
any user with central connection management can access 
to all of these connections. It also allows any user to add 
new connections, which are then available to all other 
users. 

Send UDM in Hex mode UDM files are loaded in the service and REGPara in hex 
mode. This method have to be used when sending in 
normal mode is unsuccessful due to the character set used 
on the PC (e.g. Chinese locale). The transmission process 
takes significantly longer in HEX mode. 
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 Panel 

With the Panel you can bring your devices directly to the desktop. It displays an accurate 
replica of each device and its operating options. The current device with identifier and 
name, as well as the connection used are listed in the title bar.  
The Panel can be operated both using the mouse and the keyboard. 

 

Operation with the mouse 

The controls correspond to the buttons on the related device. A (single) click with the left 
mouse button on a control is equivalent to pressing the relevant button on the unit. Double 
clicks are unnecessary.  

 

Home screen (view after start) of the panel 

The home screen can be selected in the WinREG configuration (see page 15). 

 

Standard view (all supported devices) 

Here, only the current front panel of the main unit (e.g., REG-D ™) is shown. The status of 
the inputs and outputs is not visualized. 

 

 
  

Device selection, alternatively, you can click in 
the display to change device. 

Selection of view.   

Here, depending on the device and the 
software 

features  

various 

views 

can be 

switched to. 

Button to fold the menu bar out and in. 
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Operation with the keyboard 

When operating with the keyboard, the following keys are processed (upper or lower case 
letters are not distinguished): 

 

PC key Function of the device 

1 F1 key 

2 F2 key 

3 F3 key 

4 F4 key 

5 F5 key 

a Automatic key 

h Manual key 

r Local/remote key 

m Menu key 

< Left arrow key 

> Right arrow key 

+ Up arrow key 

- Down arrow key 

# Enter key 

! ESC key 

k Display list of available devices by name 

K Display list of available devices without name 
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Standard view with I/O (only REG-D™, REG-DA and PAN-D) 

Here the main device (e.g. REG-D™) is displayed with the connected COM3 expansion 
modules BIN-D with binary inputs, relays and LED and as well ANA-D analogue channels. If 
no COM3 modules are present, only the main device with internal inputs, relays, LEDs and 
analogue channels are shown. 

 

 
Standard panel view with inputs and outputs 

 

The designation of the “LEDs“ is taken from the relay or binary input assignment. For this 
purpose, the channels of the BIN-Ds must be assigned to the inputs and outputs of the 
REG-D™ (COM3 mapping).  
The relay is displayed with red LEDs, binary inputs are displayed with green LEDs. The color 
of the LEDs from a BIN-D with free programmable LEDs is adopted from programming. That 
means the LED lights up in the panel with the same color as on the BIN-D. Exceptions are 
special conditions such as flashing LED. In this case, the LED in the panel is shown in red. 

 

Transformer-Monitoring – View (only REG-D™ and REG-DA) 

In the TM view important parameters are displayed for transformer monitoring. This view 
can only be selected when the REG-D(A)™ has the TM1/T1 feature. 

 

 
Panel TM view   
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 Terminal 

The Terminal opens up the possibilities of direct communication with the system using the 
programming language REG-L, via which all parameters and functions of the device can be 
adjusted. 

After starting the terminal, the device identifier of the connected device (prompt) appears 
after pressing the enter key, provided that a connection is correctly established with the 
device. The connection through which communication is established with the device is 
visible in the lower left corner and can be changed any time via "File\Connection".  

 

 
 

 

 

Using "File/Recording" it is possible to record entered commands and responses of the 
device in a text file. In particular, the recording function is useful for recording the REG-L 
instruction reference. Under "File/Recording" first enable recording of the terminal and 
select a text file in which the recording will be saved. Then enter the instruction "? book" in 
the terminal and press Enter. This will read the entire REG-L instruction reference from the 
device. This process can take up to 15 minutes to complete. Once the instruction reference 
has been read out, the recording should be stopped again under "File\Recording". 

  

Device identifier of 
the connected device 
(prompt) 

Online mode display 

Selected connection 
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Moreover, in the Terminal under Options the following settings can be made: 

Menu item  Description 

Colours The background and font colours (foreground) of the terminal can be 
changed. 

Fonts Adjusting the font of the terminal. 

Translation If an OEM font is used, it has to be translated to Windows ANSI to be 
properly displayed. In this case "Translate" must be activated. 

Online mode In online mode, the interface is completely occupied by the terminal 
and output on the connection occurs continuously without delay. 

ECLADR mode The ECL address mode can be used to specifically address multiple 
COM1 interfaces converted to RS485 and mutually connected. 

Reset With Reset, the ongoing dialog can be reset or aborted. For example, 
readout of the REG-L instruction reference can be terminated. 

Settings Timeout, the time the terminal waits for a response to a sent 
command, can be configured under settings. 

 

 

 

Terminal help menu item 

Further information about the terminal is also available in the help menu item of 
the terminal. 
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 Service 

Service makes it possible to read and archive logbook and tap statistics of the connected 
devices. Moreover, settings can be made for daylight savings time, allocation of add-on 
modules, remote control of simulation mode, sending and readout of background 
programs, as well as RAM-Backup. In addition it’s possible to manage the software features 
and the password protection of the COM interfaces. 

 

2.7.1 Control 

In the upper left pane of the Service program device selection is located. Furthermore in 
the upper right pane the monitor for measured value and login manager for a connection to 
a serial port with password protection can be started. A way for switching between 
AUTO/manual state, setting up the time and set points is possible in the main screen of the 
menu “Control”. 

 

 
 

 

 

  

Device selection 

Device selection opens 
automatically when an action 
is to be executed but no 
device is selected.  

Manual/automatic switching:  

MANUAL/AUTOMATIC 
operating mode  

Time setting:  

The selected device, or an 
entire group of devices, is set 
to the PC time, including date. 

Login Manager:  
Login on a serial port with 
password protection of a 
device.  

Reading setpoint settings (step 1) 

Displaying configured setpoints 

Selection setpoint index (step 2) 

Sending setpoint index  

selection (step3) 

Measurement value monitor:  

Online displaying of certain 
readings. 

Also starts automatically if the 
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2.7.2 Log 

The logbook of the REG-D(A)™ and PAN-D can be read, archived and deleted via the tab 
"Log\REG-D(A)+PAN-D“.  

 

 
 
  

Display screen for 
logbook 

Reading of the logbook from the selected device (step 1) 

Copying contents of the logbook to the clipboard 

Saving contents of the logbook to a file (*.log) 

Printing contents of the logbook 

Deleting content of the 
logbook on the device 

Opening/viewing a logbook file on the PC 
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  Furthermore the logbook of the REG-DP(A) is available via the menu “Log\REG-DP”. 
 

 
 
  

Display screen 
for logbook 

Reading of the logbook from the selected device (step 1) 

Deleting content of the logbook on the device 

Saving contents of the logbook to a file (*.log) 

Show binary inputs and relays in 
the logbook of the device 

Opening/viewing a logbook file on the PC 
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2.7.3 Statistics 

The statistics of REG-D™ can be read out and displayed with the Statistics function of the 
Service screen. 

 

 
 

 

 

  

Graphical display of tap statistics 

Tap sums with and without load 

Tabular display of tap statistics 

Deletion of device statistics 

Printing of statistics 

Copying statistics to clipboard: 
Hereby, both the table as well as the graph are copied. 

Reading of the device statistics (step 1) 
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2.7.4 Simulation 

 DANGER! Tap commands which are triggered in simulation mode are actually 
output over the relays.  

Since measured voltage is not used in simulation mode, this can lead 
to impermissible changes in the actual voltage at the transformer! 

 If the transformer the regulator is connected to is in operation, 
the simulation mode should only be used under extreme 
caution. Here, tap commands from the regulator to the tap 
changer must be separated in terms of hardware (e.g. opening 
of the terminals). 

  

 

The Simulation tab enables remote control of the REG-D(A) simulation mode. 

 

 
 

 

Measurement value monitor 

On starting the simulation, the measurement value monitor starts automatically. 
Here the simulated measurements can be checked. 

Reading device state (step 1) 

Sending selection to the device 
(step 3) 

Device state 

Activation/deactivation of the simulation modes 
(step 2) 

Simulating measurement values in the device (step 5) 

Setting measurement values for the simulation 
(step 4) 
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2.7.5 I/O extensions (COM3)  

In the tab "I/O Mapping (COM3)“ assignment of the BIN-D and ANA-D expansion modules 
to the inputs and relays of the REG-D(A) can be made/changed. 

 

 
  

Wizard for the automatic assignment of COM3 devices 

Number of channels including the channels of the device (e.g. REG D™).   

Here, virtual channels can be generated, which can then be assigned values via Modbus, for 
example. 

Reading mapping information from the device (step 1) 

Sending mapping to the device 
Deleting mapping settings; all 
channels are set to address 0 
and device channel 0 (no 
mapping). 

Starting automatic assignment 

Manual mapping; mapping information can also be specified 
manually for each channel (e.g. relays of REG D™). 
Assignment is done by entering the COM3 device address 
and device channel in the corresponding row.  

By selecting multiple channels and pressing the right mouse 
button, a completion assistant can be used. 
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2.7.6 Summertime Adjustment, UTC 

The tab "Summertime Adjustment, UTC" allows you to define rules for daylight saving time 
and the time zone setting. There are templates for certain countries.  
 

 
 

 

  

Reading the current DST rules for the year xxxx from the device 

Define "End of DST" as the last Sunday in October at 3:00 a.m., for 
example. 

Define "Start of DST“ as the last Sunday in March, at 2:00 a.m., for example. 

UTC settings: 
Here, the time zone (difference to GMT, e.g. Germany = 1h), use of summer/winter time 
and hemisphere settings can be made. Before an adjustment is possible, the current 
settings must be read from the device first. These settings are particularly important when 
time synchronization is done by means of UTC(GMT) time (e.g. IEC 61850). 

Loading pre-defined rules for specific countries 

Sending the rules to the device and defining validity 
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2.7.7 REG-L 

The "REG-L" tab allows you to open, edit, send, read and save REG-L Files (e.g. H-programs). 

 

 
 

Only certain parts (markings, lines, etc.) of the REG-L scripts can be sent via the context 
menu (right click). 

  

Saving a REG-L file under a new name 

Sending an open REG-L script to a 
device 

Sending an open REG-L script to 
several devices 

Opening a REG-L file 

Saving a REG-L file 

Reading REG-L from a device 

Monitor: 
Shows what is being sent to the 
device. 

The log function produces a recording of 
communication to a file. It must be activated 
prior to sending. 

Delete REG-L from a device 
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2.7.8 UDM 

The "UDM" tab allows you to open, edit, send, read and save UDM Files. This feature is not 
available with activated communication via WinPQ. 

 

 
 

  

Saving a UDM file under a new name 

Sending an open UDM script to a 
device 

Sending an open UDM script to 
several devices 

Opening a UDM file 

Saving a UDM file 

Reading UDM from a device 

Monitor: 
Shows what is being sent to the 
device. 

Delete UDM from a device 
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2.7.9 RAM-Backup 

The "RAM-Backup" tab allows you to control backup of parameters and the background 
program in the flash memory. The prerequisite for this is a bootloader version ≥ V2.12 and 
appropriate hardware. Details on RAM-Backup can be read in chapter RAM-Backup of REG-
D(A) manual. This feature is not available with activated communication via WinPQ. 

 

 
 

 

 

Starting the bootloader. With firmware version <V2.22 or the feature bootload = 0, the 
bootloader must be started manually (step 1). 

Restoring data from a backup. As of firmware version V2.22, 
when needed, this is run automatically after a power-on reset 
(step 2: restoration). 

Exit the bootloader (step 3). 

Backing up in the flash memory (step 2: creating a backup). 

Date of the last backup, if a backup is available. An existing backup is not 
detected until after starting the bootloader. 
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2.7.10 Features 

The software features of the devices can be modified on the "Features" tab. 

Both the modification of free features and the activation of protected features (for a fee) 
are possible. 

A device-specific activation code or a corresponding code file is required to activate 
protected features. 

 

 
 

 CAUTION! Changing the device behavior by changing the software 
features 

Changing software features and the resulting altered behavior of 
the device can lead to unwanted reactions of the device and 
damage to the equipment. 

 Do not make any changes to the software features if you are 
not sure about the effects. In case of doubt, contact the 
A.Eberle Support. 

 

 

 

Changing software features via parameterization (REGPara) 

Depending on the feature to be changed and the settings (Activate Sending of 
Protected features) of REGPara, the software features can also be edited in the 
parameterization and sent to the device. However, it is not possible to enable the 
features by code there. 
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2.7.11 User Management (COM) 

The user management (password protection) for the serial interfaces can be set up on the 
"User management (COM)" card. 

To do this, the current status of the password protection is first read from the device using 
the "Read" button. If no password protection is active yet, it can be activated by assigning 
an Admin password. Subsequently, the authorizations for the individual users, their 
passwords and the timeout can be set. The timeout determines the time after which the 
corresponding user is automatically logged out. The setting zero means that no automatic 
logout takes place.  

The following settings are available for the rights (grants): 

Auswahl Beschreibung 

0 (no grants) The user have no grants* 

1 (Local R/-, ELAN -/-) The user is allowed to read data on the local device 

2 (Local R/-, ELAN R/-) The user is allowed to read data on the local device and via E-LAN 

3 (Local R/W, ELAN -/-) The user is allowed to read and write data on the local device 

4 (Local R/W, ELAN R/-) The user is allowed to read and write data on the local device and to 
read data via E-LAN 

5 (Local R/W, ELAN R/W) The user is allowed to read and write data on the local device and via 
E-LAN 

* certain information can be read even without read or write grants 

 

With the button "Deactivate usermanagement" the password protection for the serial 
interfaces can be switched off. 

The settings in the "COM Port Protection" field can be used to exclude certain serial ports 
from password protection. 
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Exception of the COM2 from the password protection for the SCADA connection! 

If the device has a SCADA system connection, the SCADA interface card is usually 
connected to the COM2 of the device. In this case, COM2 must be excluded from 
the password protection! 

 

 

User management (COM) and Role Based Access Control (RBAC) 

The user management (COM) can only be used for simple password protection of 
the COM interfaces. It does not represent a role-based user management. 

If the role-based access control is used by means of the SCADA interface card, no 
settings are required for the user management (COM). If settings are nevertheless 
made, these are superimposed on the RBAC. 

It is not possible to log on to the COM interfaces with the RBAC access data. 
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 REGPara 

REGPara is used for simple parameter assignment of individual components. Individual 
parameters can be entered with a tree-view arrangement, stored for future use, or 
transferred to another regulator. This transfer is also possible via E-LAN. 

 

On starting REGPara, a window appears next to the WinREG 
configuration for selecting device type. Select the appropriate device, 
in this case REG-D™, and click OK to load the WinREG configuration 
interface corresponding to the device.  

 

 

The WinREG configuration interface is structured as follows: 

 

 
 

 

 

  

Send device 

Read device 

Load file 

Save file 

Print file 

Exit 

Navigation via Tree-View 

Onlinemode 

Device typ of the parameter set 
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The following actions are available via the File menu (partly also available as shortcuts in 
the WinREG configuration interface): 

Menu item  Description 

Read Device 

 

Starts reading a device. After starting, a dialog opens for selecting 
the device to be read. 

Send to Device

 

Starts sending the current parameterization to a device. A dialog 
opens to select the target device. After the action "Send to device" a 
final dialog for selecting the parameters to be sent is displayed. 

The following parameters can be selected for sending: 

0 Basic parameters 

0 Identifier 

0 Features 

0 COM interface settings 

0 E-LAN interface settings 

0 COM3 mapping 

0 Expert parameters 

0 DST settings 

0 P-Coil (Reg-DP(A)) 

0 REG-L parameter groups 

Load file 

 

The dialog "Load parameter file" appears to open existing REGSys™ 
parameter files (*.prm). 

 

Save Buffering of saved parameter sets  

Save as … 

 
 

By clicking on "Save as" an "Additional data" dialog appears first (see 
also "Edit/Additional data"), where a printout heading and a 
comment can be entered. With the button "Insert ...", recently used 
printout headings / comments or templates can be attached. By 
clicking OK in the "Additional data" dialog, the window "Save 
parameter file" appears for specifying location and name. By clicking 
Save, the PRM file is stored as indicated. 

Import … Import of csv-files 

Export … Export the configuration in xml- (RSEI) and csv-fromat. 

Print 

 

The Print dialog appears, in which the printer and presentation can 
be defined. Firstly, font and font size can be set under presentation. 
Secondly, the order of the parameters can be arranged either as in 
the configuration of WinREG, i.e., according to the different index 
cards, or as in the device, i.e., sorted in accordance with setups 1 to 
6. 

Previous sessions Up to four of the last opened PRM files can be opened using the 
shortcut. 

Exit 

 

Exits the software. 
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After pressing the “Send to device” button, the dialog for selecting a target device opens. 
When the according device is selected, another dialog box appears for selecting the 
parameters to be sent. Each parameter group can be transferred individually to the device. 
With the help of buttons on the side of the window, all or no parameters can be selected. It 
is also possible to reverse the selection of the parameters using the "Invert" function. 

 

 
Select parameter groups to be send to a device 

 

With the "OK" button, the selection is confirmed and the data transfer to the device starts. 
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If there are differences in the software features between the parameter set and the target 
device, these differences are displayed: 

 

 
Dialog „Differences in Feature List“ 

 

In the default setting, the non-protected features (no $ sign) can be transmitted to the 
target device by activating the "Send unprotected features" option. Protected features 
must be activated with an activation code via the service tool. 

If the "Activate Sending of Protected features" option is active in REGPara, protected 
features can also be sent to the target device. This function is password protected and 
normally reserved for A. Eberle. 

 
 

 CAUTION! Changing the device behavior by changing the software 
features 

Changing software features and the resulting altered behavior of 
the device can lead to unwanted reactions of the device and 
damage to the equipment. 

 Do not make any changes to the software features if you are 
not sure about the effects. In case of doubt, contact the 
A.Eberle Support. 
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Software features (Features) 

With the software features, additional functions can be enabled or the system 
behaviour of the device can be adapted. Some parameters are only available if the 
corresponding feature is set. It is therefore important that the target device has 
the same features as the parameter set. If this is not the case, the behaviour of the 
device may deviate from the behaviour expected from the parameter set. Fur-
thermore, error messages may occur during the transmission of the parameters. 

 

The progress bars for the transmission of the individual parameter groups then appear. For 
the basic parameters, a comparison is also performed before transmission. 

At the end of the transmission, a dialog shows which parameter groups were transmitted 
and whether errors occurred.  
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The following actions are also available via the Edit menu: 

Menu item  Description 

Compare 

 

There are two modes available:   
The current parameter settings can be compared to a device, or also 
to an existing parameter file (*.prm). After the comparison, a related 
dialog appears in which the various parameters are listed with their 
respective values.   
H-Programs are not included in the comparison. 

Additional Data Here a printout heading and a comment for the current 
configuration can be entered. With the button "Insert ...", recently 
used printout headings / comments or templates can be attached. 
The "Additional data" dialog also appears the first time you save the 
current configuration, or with Save as. 

Change Device 
Type 

Device type, e.g. REG-D™ or PAN-D, can be changed here. Please 
note that all previously altered parameters may be irretrievably lost 
with change of device type. If necessary, save the current parameter 
settings before starting. 

Convert 

 

 

With the convert function, a set of parameters of a  
REG-D™ can be converted to a set of parameters of a REG-DA and 
vice versa. This results in changes, in particular, with regard to the 
available binary inputs/outputs and analog channels. To transfer a 
parameter set to a device, the device type of the parameter set 
must match the type of device. A conversion can also be made 
between different firmware versions. 

Configuration Enabling special features: 

This feature allows you to send locked (often fee required) 
characteristics of the parameter file to a device. By default, sending 
locked features is not available. The function is password protected. 

 

Edit the expert parameters: 

This parameter activates editing the expert parameters. The 
function is password protected. 

 

Read Service informations: 

If this parameter is active the WinREG reads additional service 
information about the device and the E-LAN during parameter 
readout. This could be very helpful in case of any issue. With this 
setting active the parameter readout takes significantly longer. 

 

 

 

REGPara help menu item 

Further information about configuration is also available in the configuration help 
menu item. 
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 REGView 

 

 

 

REGView is used to view and analyse data of the S1 recorder. These can either be accessed 
directly on the REG-D(A) (online), or via data from an archive file of the Collector. 

 

Legend 

Selection of interval start date 

Selection of interval duration 

Undo zoom 

A zoom step back 

Display of recorded data 

Adaptation of the respective Y-axis (by clicking on the 
corresponding point on the Y axis): 

a: Push axis upwards 
b: Zoom in 
c: Zoom out 
d: Push axis downwards 

Shortcut to display charts 

Data update (online or 
archive file) 

a 

b 

c 

d 

Characteristic zoom by mouse: 
XZ: Zoom only enabled on the X axis 
BZ: Zoom on the X and Y axes enabled 
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The following actions are also available in the File menu: 

Menu item  Description 

Open Opens the RegView dialog to select the recorder data file. 

with Refresh on 
Update 

If you are at the end of a RegView file, a screen refresh is run 
automatically on updating this file (exception: not in zoom mode, 
nor with activated measuring bars). The option is enabled by 
default. 

Online The connected device is read using the refresh button. 

Device selection … If the menu item Online is enabled, the device to be read can be 
selected here. 

Edit Connection  
List … 

Opens the "Edit connections" dialog. 

Data-Export Opens the "Data export" dialog in which recorder data can be 
extracted. 

Chart-Export Opens the "Chart export" dialog in which the current display of 
RegView can be exported in various file formats. 

Statistics … Evaluates a specified period for Umax (with time stamp) / Umean 
/ Umin (with time stamp) and tap statistics. 

Print Opens the Print dialog 

Previous sessions Up to five of the last opened REGView files can be opened using 
the shortcut. 

Exit Exits the software. 
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The following actions are available in the Edit menu: 

Menu item  Description 

Copy Chart Copies the chart to the clipboard. 

Copy Readings Measurements can be applied with a double click on the RegView 
graph field. The values are shown below the heading. With the 
menu item, displayed measurements can be copied to the 
clipboard. 

Remove Llast 
Reading 

Remove the last measurement. 

Remove All Readings Remove all measurements. 

Modify Last Reading The time stamp of the last measurement can be adjusted. 

Edit Current 
REGView File 

Opens the current RegView recorder data file in the text editor. 

Quick Setup … Opens the "Quick setup" dialog to configure the curve display, 
the clipboard format and select whether the window size and 
position, and the skin settings are to be saved at end of program. 

Chart Setup … Under this menu item, the chart can be configured in detail. 
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The following actions are available via the View menu: 

Menu item  Description 

Curve Selection Opens the "Quick setup" dialog 

Tile Vertically By default, this parameter is set active, the recorded channels are 
shown as individual superimposed graphs. If the parameter is 
deactivated, the recorded channels are plotted simultaneously in 
a graph. 

Compress from 24h / 
14days (DP) on 

If the parameter is enabled, with a REG-D™ and a representation 
of >24h, or with a REG-DP and a representation of >14d, the data 
is shown compacted in order to optimize computing power. The 
compression can partially result in display problems. In this case, 
disable the parameter again. 

Interval Start Interval start time can be set in this menu item. 

Interval Period … A click on this menu item leads to selection of the interval 
duration on the RegView screen. 

Box Zoom If Box Zoom is enabled, a zoom in the X and Y axis directions can 
be carried out using the mouse. If Box Zoom is disabled, a zoom 
can only be carried out in the X axis using the mouse. 

Undo Zoom Zoom out of the interval 

Zoom Out A zoom step back 

Zoom range   
Full Range or Last 
Full Range 

A zoom step back 

Refresh Reloads the recorder data file or the recorder data of the 
connected device. 

 

 

 

The following actions are available via the Scaling menu: 

Menu item  Description 

Apply Knu, Kni If the menu item is selected, recorded secondary data (e.g. on 
100V normalized voltage) are multiplied by the regulator Knu for 
display, to indicate primary values. 

U AUTO Automatic scaling of the voltage graph 

U +/-3% Scaling of the voltage graph to U +/-3% 

U +/-5% Scaling of the voltage graph to U +/-5% 

U +/-10% Scaling of the voltage graph to U +/-10% 

U +/-20% Scaling of the voltage graph to U +/-20% 

U Tolerance band Scaling of the voltage graph to the tolerance band 
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The following actions are available in the Extras menu: 

Menu item  Description 

Start Collector Starts the Collector program. 

Edit Device 
Associations in 
REGView-LookUp.ini 

Under this menu item, an INI file is created to set a title line, 
subtitle line and footer for all devices collectively and for each 
device individually. 

Path Settings Here the exact path settings of the recorder data files, etc. can be 
specified. 

Recall Skin Settings There are several pre-defined skin settings to choose from. 

Store Skin Settings Save current skin settings. 

 

 

 

 

REGView help menu item 

Further information about REGView is also available in the REGView help menu 
item. 

 

 

Data of Recorder S2 

For devices with characteristic S2, other recording options are available in addition 
to the data of recorder S1. The data of the S2 recorder cannot be visualized with 
REGView. For this purpose, please use the A.Eberle Toolbox™ software. 
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 Collector 

The Collector reads the data from the Recorder function S1 of the REG-DA and archives 
them on the PC. 

 

 
 

 

 

Message: "File header does not correspond to actual device data" 

The message "File header does not correspond to actual device data" may appear 
in step 3 of "Update / New Creation" in case of updating an existing Collector file. 
This message is generated when parameters, such as the voltage transformer fac-
tor Knu, have changed since the last update. In this case, it is advisable to create a 
new Collector file, as otherwise it may lead to incorrect calculation of primary val-
ues from the secondary values stored in the Collector file in the RegView software. 

 

  

Instructions on how to proceed 
if device selection has not been 
created. 

Create device selection:  

E-LAN is searched for 

devices with a Recorder 
function. 
(step 1) 

Select the desired devices:  
If "Suggest existing Files 
only" is selected, already 
selected Collector files are 
selected automatically. 

(step 2) 

Start Update / New 
Creation: 
Starts downloading recorder 
data and adds them to an 
existing Collector file of a 
device, if necessary.  
(step 3) 

Activity log: 
Please wait until recreation or update has been 
performed for all of the selected devices. (step 4)  
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The following actions are availablevia the File menu: 

Menu item  Description 

Create Device 
Selection 

E-LAN is searched for devices with a Recorder function. 

Start Update / New 
Creation: 

Starts downloading recorder data and adds them to an existing 
Collector file of a device, if necessary. 

Device Selection + 
New Creation 

E-LAN is searched for devices with a Recorder function. It starts 
after download of the recorder data. 

Select 
Connection … 

Starts the Select Connection dialog. 

Close Connection … Terminates the active connection. 

Edit Connection 
List … 

Starts the Edit Connections dialog. 

Visualize highlighted 
File 

Starts displaying the selected file in the RegView program part. 

Edit highlighted File Opens the selected file in the Editor. 

Update highlighted 
File 

Updates selected file. 

Exit Exits the software. 

 

 

 

The following actions are available via the Batch menu: 

Menu item  Description 

Create/Execute 
Batch 

Opens the "Collector Batch" dialog, in which a batch file can be 
created and run.  

Execute Batch File … An existing batch file can be selected to be executed. 

Edit 
Batch File … 

An existing batch file can be selected to be edited. 

Execute Single Batch 
Command ... 

Run batch command directly. 

Alarms … Opens the "Collector - Alarms" dialog, in which different alarms 
can be defined. 

Cancel All Alarms ... Deletes all alarms defined in the "Collector - Alarms" dialog. 

Quick-Access 
Allocation 

Batch files can be assigned to a key combination. 

Abort Batch (ESC) Cancels the currently running batch. 
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The following actions are available via the Extras menu: 

Menu item  Description 

Extended File Test ... Opens a new window with the integrated, self-explanatory 
recorder file test and repair program. 

with Device Time 
Sync 

With this menu item, the time synchronization of the REGSys™ 
device time built-in as of V1.3.2 can be activated by the PC clock. 
Time synchronization takes place before updating/rereading. 

with Complete File 
Test 

With this menu item the file test built-in from V1.3.2 can be 
activated and deactivated. The file list will be executed after the 
update, each file line is checked for correctness (message box in 
case of error). 

Precedure on Header 
Change 

Four selection options: Do not overwrite, overwrite, ask (default), 
do not overwrite but update 

With Additional 
REG-D(A)/PAN-D 
Logbook Update Of 
All Listed Devices 

Device logbooks of REG-D™, REG-DA and PAN-D devices can be 
automatically saved/updated as of REG-D ™, REG-DA and PAN-D 
firmware V2.11. On the next update, the recorder data are read 
first and then the logbook data. For unticked devices, no recorder 
data are read, but the logbook is read. 

View Logbook Of 
Highlighted Device 

Opens the logbook of the selected device. 

Optional Start 
Date … 

If recorder data are first to be stored as of a certain date, the 
start date can be set with this menu item. This date is only 
considered on creating files! 

Path Settings From software version V1.4.0, the file name extension of ".txt" 
was changed to ".rvt" and already existing files are renamed 
accordingly on updating. In the "Extras\Path Settings" menu the 
extension can be manually changed to ".txt". 

Log Events Selection of events to be logged 

View Log File Opens the log file of the Collector. 

 

 

 

Collector help menu item 

Further information about the Collector is also available in the help menu item of 
the Collector. 

 

 

Data of Recorder S2 

For devices with characteristic S2, other recording options are available in addition 
to the data of the recorder S1. The data of the S2 recorder cannot be read out with 
the WinREG Collector. For this purpose, please use the A.Eberle Toolbox™ soft-
ware. 
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 WinTM/WinDM 

The WinTM module (parameters for the transformer monitoring module) and the WinDM 
module (parameters for the transformer monitoring device without Relay for Voltage 
Control & Transformer Monitoring) complete the software package. These modules are not 
part of this user manual. 
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4. Contact 

For questions, please contact the A. Eberle REGSys™ support team: 
 

A.Eberle GmbH & Co.KG  

Frankenstr. 160  

D-90461 Nuremberg  

 

E-mail:   regsys-support@a-eberle.de  

Phone:   +49 911 / 62 81 08 -101  

Fax:    +49 911 / 62 81 08 -96  

Homepage:  https://www.a-eberle.de 
 

 

https://www.a-eberle.de/
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